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1. C/C++  

1.1 8ƖƐŪŴūǂƲŗ >ŗǚŗƉƖƯƏŗƐƽ BƐǚŴƲƖƐƏŗƐƽ 

The following uses configuring Debug Win32 as an example. For other build types and platforms , 

please refer to the end of this chapter.  

1. Open Visual Studio 2019 and create a new project; 

2. After creation is complete, copy the "Windows\HTRA_API" folder from the delivery USB 

drive to a directory at the same level as the project; 

 

Figure 1 Copy the HTRA_API file 

3. Double-click to open SWP.sln, right-click on "Source Files" -> "Add" -> "New Item" -> "C++ 

File (.cpp)" to create a new SWP.cpp file; 

4. Click "Project" -> "Properties" in the menu bar, set "Configuration" to "Debug" and "Platform" 

to "Win32"; 

5. In Configuration Properties -> Debugging, set the Environment variable to 

"Path=..\HTRA_API\x86"; 

 

Figure 2 Configure environment variables 

6. In Configuration Properties -> C/C++ -> General, set the Additional Include Directories to 

"$(SolutionDir)\HTRA_API\x86"; 
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Figure 3 Add additional include directories 

7. Set the "Additional Library Directories" under Configuration Properties -> Linker -> General 

to "$(SolutionDir)\HTRA_API\x86"; 

 

Figure 4 Configure additional library directories 

8. Add "htra_api.lib" to "Additional Dependencies" under Configuration Properties -> Linker -> 

Input, then click "OK". 

 
Figure 5 Configure additional dependencies 

Â Configure Release Win32: Set "Configuration" in Step 4 to "Release", and keep all other 

settings unchanged; 

Â Configure Debug x64: Set "Configuration" in Step 4 to "Debug" and "Platform" to "x64". Also 

replace all environment variables or additional directory paths containing "HTRA_API\x86" 

with "HTRA_API\x64";  

Â Configure Release x64: Set "Configuration" in Step 4 to "Release" and "Platform" to "x64". 

Also replace all environment variables or additional directory paths containing 

"HTRA_API\x86" with "HTRA_API\x64";  
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1.2 ÍƶĴūŗ ºƲƖōŗƶƶ ŪƖƲ 8ͺͺ BǠĴƏƯƉŗƶ 

Note: Only one example can run at a time, and the example cannot run simultaneously with 

SAStudio4 . 

1.2.1 ÍƶĴūŗ ƖŪ WŗƐŗƲĴƉ 8ͺͺ BǠĴƏƯƉŗ 

1. Use Visual Studio to open the solution HTRA_C++_Examples.sln located in the folder 

Windows\HTRA_API_Example\HTRA_C++_Examples on the provided USB drive; 

2. Click the HTRA_C++_Examples project on the right, then open the main.cpp file under the 

Source Files folder; 

3. Each example program is encapsulated in a separate function. To use one, uncomment the 

corresponding routine, save the file, select the build architecture, and then click Run. 

 

Figure 6 Run the Device_GetDeviceInfo example 

1.2.2 ÍƶĴūŗ ƖŪ ƽűŗ y̌Uy >ŗƏƖœǂƉĴƽŴƖƐ BǠĴƏƯƉŗ 

1. Open the solution Htra_Demodulation.sln in 

Windows\HTRA_C++_Examples\Htra_Demodulation on the supplied USB drive using 

Visual Studio; 

2. Click the Htra_Demodulation project on the right, then open the main.cpp file under the 

Source Files folder; 

3. In the C++ example package, each demo routine is encapsulated in a separate function. To 

run a demo, uncomment the corresponding routine, save the file, select the build 

architecture, and click Run. 
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1.2.3 ÍƶĴūŗ ƖŪ ƽűŗ ½ŗōƖƲœŴƐū ĴƐœ ºƉĴǡŌĴōƇ BǠĴƏƯƉŗ 

1. Open the solution Htra_RecordingandPlayBack.sln in Visual Studio, located in the USB drive 

under Windows\HTRA_API_Example\Htra_RecordingandPlayBack; 

2. Double-click the Htra_RecordingandPlayBack project on the right to open the main.cpp file 

in the source files; 

3. Each routine in the recording and playback example is encapsulated in a separate function. 

To use the example, simply uncomment it. 

Â Usage of the Reading Example 

1) For example, when reading SWP mode stream disk data, uncomment the 

SWPMode_PlayBack function and save; 

2) Place the recording file generated in SWP mode into the folder 

Windows\HTRA_C++_Examples\Htra_RecordingandPlayBack\Htra_RecordingandPlayBa

ck\data; 

 

Figure 7 Place the recording file under the standard spectrum analysis mode 

3) Click to enter SWPMode_PlayBack.cpp and modify the name of the recorded file in the 

SWPMode_PlayBack() function; 

 

Figure 8 Modify the recording file name 

4) Running the program will generate the parsed data file "SWPMode_Data.txt" in the data 

folder under the SWP mode. 

 
Figure 9 View the parsed data in SWP mode 
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Â Usage of the Recording Example 

1) For example, when testing the IQSMode_Recording routine, uncomment and save; 

2) Click to enter the IQSMode_Recording() function, configure the relevant parameters, and 

then run the program. During execution, the file will be continuously recorded until manually 

stopped; 

3) The recording file data in IQS mode can be found in the 

HTRA_C++_Examples\Htra_RecordingandPlayBack\Htra_RecordingandPlayBack\data 

folder. 

 

Figure 10 View the recorded file data in IQ streaming mode 

1.3 >ŗǚŴōŗƲ̡ŗƉĴƽŗœ 

1.3.1 Wŗƽ >ŗǚŴōŗ `ƐŪƖƲƏĴƽŴƖƐ 

Device_GetDeviceInfo.cpp: Get device information, including API version, USB version, device 

model, device UID, MCU version, FPGA version, and device temperature.  

1.3.2 >ŗǚŴōŗ ÁƽĴƐœŌǡ 

Device_SysPowerState.cpp: An example of setting the device's standby state, which can be 

configured to normal operating state or RF powered down state (low power).  

1.3.3 WzÁÁ̡ƲŗƉĴƽŗœ 

Device_AboutGNSS.cpp: Retrieves information such as latitude, longitude, altitude, and time 

obtained from the GNSS module, acquires GNSS - related latitude and time information from 

MeasAuxInfo in SWP mode, and obtains latitude and time information from 

IQSt ream.DeviceState in IQS mode.  

1.3.4 Wŗƽ ĴƐœ ƏƖœŴŪǡ ƽűŗ `º ĴœœƲŗƶƶ ƖŪ ƽűŗ zë œŗǚŴōŗ 

Device_GetAndSetIP.cpp: Retrieve the device's IP address and modify it using the device UID 

or the device's current IP address.  

1.3.5 yƖœŗ ƶǛŴƽōűŴƐū ƽŴƏŗ ōƖƐƶǂƏƯƽŴƖƐ 

Device_ MeasureModeSwitchTime .cpp: Get the time required for the current host computer to 

switch between different modes.  
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1.4 ÁæºyƖœŗ 

1.4.1 ʍʌ y]Ǫ ½ŗŪŗƲŗƐōŗ 8ƉƖōƇÍƶŴƐū `ƐƽŗƲƐĴƉWzÁÁ yƖœǂƉŗ 

SWP_GetSpectrum_Standard.cpp: Obtain spectrum data by calling the function interface.  

1.4.2 yĴǠŴƏǂƏ ĴƐœ ƏŴƐŴƏǂƏ űƖƉœ 

SWP_MaxHold_MinHold.cpp: Set the trace mode to MaxHold or MinHold, and use 

SWP_ResetTraceHold to reset the hold.  

1.4.3 ǚŗƲĴūŗ ÈƲĴōŗ 

SWP_TraceAverage.cpp: Average processing of the acquired trace.  

1.4.4 ǂƽƖƏĴƽŴō 8ƖƐŪŴūǂƲĴƽŴƖƐ yŗĴƶǂƲŗƏŗƐƽ 

SWP_AutoSetMeasure.cpp: Automatically configures relevant parameters based on specific 

SWP applications, completing measurements by issuing automatic configuration parameters.  

1.4.5 UƲŗƱǂŗƐōǡ 8ƖƏƯŗƐƶĴƽŴƖƐ 

SWP_SetFreqCompensation.cpp: When an external attenuator is present, compensation can 

be applied to the corresponding frequency band to ensure that the test results remain accurate.  

1.4.6 UǂƐōƽŴƖƐ ŗǠŗōǂƽŴƖƐ ƽŴƏŗ˿ ƶǛŗŗƯ ƶƯŗŗœ˿ ĴƐœ ƽűƲƖǂūűƯǂƽ 

SWP_TimeOfSetFunction.cpp: Obtains the call duration of the SWP_Configuration, 

SWP_GetPartialSweep, and SWP_GetFullSweep functions, along with the sweep speed and 

throughput under the current configuration.  

1.4.7 ¡ŌƽĴŴƐ ƶƯŗōƽƲǂƏ ƯŗĴƇ ǚĴƉǂŗƶ 

SWP_PickMaxPower.cpp: Obtain the maximum power point of the current spectrum and its 

corresponding frequency point.  

1.4.8 ÁŴūƐĴƉƶ ĴƐœ ÁƯǂƲŴƖǂƶ 

SWP_GetSpectrum_SigAndSpur.cpp: This can distinguish between signals and spurious after 

obtaining spectrum data . 

1.4.9 ÁŴƏǂƉƽĴƐŗƖǂƶ ōƱǂŴƶŴƽŴƖƐ ƖŪ ÁƯŗōƽƲǂƏ ĴƐœ `¼ 

SWP_GetSpectrumAndIQS.cpp: This allows for the simultaneous acquisition of spectrum data 

and IQ data.  

1.4.10 ½ŗĴœŴƐū Áæº ÁƽƲŗĴƏ >ŴƶƇ >ĴƽĴ ŪƲƖƏ ƯƯƉŴōĴƽŴƖƐ ÁƖŪƽǛĴƲŗ 

SWPMode_PlayBack.cpp: This can read the recorded file data in SWP mode from Application 

Software and write the read spectrum data into SWP Mode_Data.txt.  
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1.4.11 ÍƶŴƐū WzÁÁ ʍʌy]Ǫ ½ŗŪŗƲŗƐōŗ 8ƉƖōƇ 

SWP_GNSSReferenceClock.cpp: This uses a high - quality GNSS module's 10MHz reference 

clock in SWP mode.  

1.4.12 BǠƽŗƲƐĴƉ ÈƲŴūūŗƲ yƖœŗ 

SWP_GetSpectrum_Trigger.cpp: This obtains spectrum data when the trigger source is set to 

external trigger . 

1.4.13 ÈƲĴōŗ ƉŴūƐƏŗƐƽ yŗƽűƖœ 

SWP_GetSpectrum_TraceAlign.cpp: Obtain spectrum data when the trace alignment method 

is set to align to the starting frequency or align to the center frequency.  

1.4.14 zǂƏŌŗƲ ƖŪ ÁƯŗōƽƲǂƏ UƲĴƏŗƶ ¡ŌƽĴŴƐĴŌƉŗ ǛŴƽűŴƐ Ĵ 8ŗƲƽĴŴƐ ÈŴƏŗ 

SWP_Fixedtime_GetFrames.cpp: Loop 50 times to obtain 10 seconds of spectrum data, 

resulting in the average number of spectrum frames that can be obtained within 10 seconds.  

1.4.15 BǠƽŗƲƐĴƉ ÈƲŴūūŗƲ 8ĴƉŴŌƲĴƽŴƖƐ ƖŪ `ƐƽŗƲƐĴƉ ʍʌy]Ǫ ½ŗŪŗƲŗƐōŗ 8ƉƖōƇ 

SWP_GetSpectrum_Calibration.cpp: An example of the device calibrating the clock via GNSS -

1PPS or through external trigger.  

1.4.16 ºűĴƶŗ ƐƖŴƶŗ ƏŗĴƶǂƲŗƏŗƐƽ 

SWP_Meas_PhaseNoise.cpp: Measur es the single - sideband phase noise (unit: dBc/Hz) of the 

received signal at the user - specified frequency deviation, supports multi - frequency point 

configuration . 

1.4.17 8űĴƐƐŗƉ ƯƖǛŗƲ ƏŗĴƶǂƲŗƏŗƐƽ 

SWP_Meas_ChannelPower.cpp: Measures the channel power of the received signal.  

1.4.18 œƃĴōŗƐƽ 8űĴƐƐŗƉ ºƖǛŗƲ ½ĴƽŴƖ yŗĴƶǂƲŗƏŗƐƽ 

SWP_Meas_ACPR.cpp: Measure the adjacent channel power ratio of the received signal.  

1.4.19 ºŗƲōŗƐƽĴūŗ ƖōōǂƯŴŗœ ŌĴƐœǛŴœƽűyŗĴƶǂƲŗƏŗƐƽ 

SWP_Meas_OBW.cpp: Measures the occupied bandwidth of the received signal in percentage . 

1.4.20 ëœ7 ¡ōōǂƯŴŗœ 7ĴƐœǛŴœƽű yŗĴƶǂƲŗƏŗƐƽ 

SWP_Meas_XdBBW.cpp: Measures the occupied bandwidth of the received signal in XdB . 

1.4.21 `yʏ ƏŗĴƶǂƲŗƏŗƐƽƶ 

SWP_Meas_IM3.cpp: IM3 measurement of the received signal.  
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1.4.22 UƲŗƱǂŗƐōǡ ŴƐƽŗƲǚĴƉ ƏĴƽōűŴƐū ½7æ 

SWP_RBW_Spaced_Trace.cpp: Makes the frequency interval between two points of the trace 

close to the set RBW value.  

1.4.23 ÍƶŴƐū ĴƐ BǠƽŗƲƐĴƉ ʍʌy]Ǫ ½ŗŪŗƲŗƐōŗ 8ƉƖōƇ 

SWP_RefCLKSource_External.cpp: Use external 10MHz reference clock. (Take the use of 

external 10MHz reference clock in SWP mode as an example, the same method is used in other 

modes).  

1.5 `¼ÁyƖœŗ 

1.5.1 ¡ŌƽĴŴƐ UŴǠŗœ zǂƏŌŗƲ ƖƲ 8ƖƐƽŴƐǂƖǂƶ ÁƽƲŗĴƏ ƖŪ `¼ >ĴƽĴ 

IQS_GetIQ_Standard.cpp: Obtain a fixed number or continuous stream of IQ data under 

professional configuration.  

1.5.2 `¼ œĴƽĴ ōƖƐǚŗƲƽŗœ ƽƖ ǚƖƉƽĴūŗ å ǂƐŴƽƶ 

IQS_ScaleIQDataToVolts.cpp: Converts the acquired IQ data into data in volts (V).  

1.5.3 ÈŴƏŗ ƽĴƇŗƐ ƽƖ Ŵƶƶǂŗ ōƖƐŪŴūǂƲĴƽŴƖƐ ĴƐœ ĴōƱǂŴƲŗ `¼ 

IQS_ConfigandGetIQ_Time.cpp: Obtains the call duration of the IQS_Configuration and 

IQS_GetIQStream_PM1 functions.  

1.5.4 `¼ ƽƖ ÁƯŗōƽƲǂƏ >ĴƽĴ 

DSP_IQSToSpectrum.cpp: Converts the acquired time - domain IQ data into spectrum data 

using spectral analysis methods.  

1.5.5 `¼ ƽƖ ÁƯŗōƽƲǂƏ ̬ǂƶŴƐū ƉŴƱǂŴœ ƉŴŌƲĴƲǡ ǚŗƲƶŴƖƐ̭ 

IQS_ToSpectrumByLiquid.cpp: Uses the liquid library to convert the acquired time - domain IQ 

data into spectrum data through spectral analysis methods.  

1.5.6 Uy >ŗƏƖœǂƉĴƽŴƖƐ ºƉĴǡŌĴōƇ 

DSP_FMDemod.cpp: Performs FM demodulation on the IQ data and plays the demodulated 

audio.  

1.5.7 Uy>ŗƏƖœǂƉĴƽŴƖƐ>ĴƽĴƐĴƉǡƶŴƶ 

IQS_FMDataAnalysis.cpp:  Audio analysis of the IQ data after FM demodulation to get the audio 

voltage, audio frequency, SINAD and total harmonic distortion.  

1.5.8 y >ŗƏƖœǂƉĴƽŴƖƐ ºƉĴǡŌĴōƇ 

DSP_AM_Demod.cpp: Performs AM demodulation on IQ data and plays the demodulated audio.  
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1.5.9 y>ŗƏƖœǂƉĴƽŴƖƐ>ĴƽĴƐĴƉǡƶŴƶ 

IQS_FMDataAnalysis.cpp:  Audio analysis of the IQ data after AM demodulation to get the audio 

voltage, audio frequency, SINAD and total harmonic distortion.  

1.5.10 >ŴūŴƽĴƉ >ƖǛƐōƖƐǚŗƲƶŴƖƐ 

DSP_DDC.cpp: Resamples the obtained IQ data.  

1.5.11 >ŴūŴƽĴƉ sƖǛº̡Ĵƶƶ UŴƉƽŗƲ 

DSP_LPF.cpp: Perform low - pass filtering on the obtained IQ data.  

1.5.12 ǂœŴƖ ƐĴƉǡƶŴƶ 

IQS_AudioAnalysis.cpp: Performs audio analysis on the demodulated IQ data to obtain audio 

voltage, audio frequency, SINAD, and total harmonic distortion.  

1.5.13 ½ŗĴœ ƽűŗ `¼Á ƶƽƲŗĴƏ œŴƶƇ œĴƽĴ ŪƲƖƏ ƯƯƉŴōĴƽŴƖƐ ÁƖŪƽǛĴƲŗ 

IQSMode_PlayBack.cpp: Parses the recorded file data in IQS mode from Application Software 

and writes the read spectrum data into the IQSMode_Data.txt file.  

1.5.14 ½ŗōƖƲœ `¼ œĴƽĴ ŴƐ ˾ǛĴǚ ŪƖƲƏĴƽ 

IQSMode_Recording.cpp: Stores the acquired IQ data in .wav format.  

1.5.15 ˾ǛĴǚ ōűĴƐūŗœ ƽƖ ˾ōƶǚ 

IQSMode_WavToCsv.cpp: Parses and extracts I and Q channel data from the .wav recording 

file data in IQS mode, converting it into a .CSV format file for saving.  

1.5.16 ÁƽƲŗĴƏŴƐū ĴƐœ ƲŗĴœŴƐū `¼ œĴƽĴ 

IQS_GetIQToTxt.cpp: Writes the obtained IQ data into a .txt file.  

1.5.17 yǂƉƽŴƽűƲŗĴœŗœ ĴōƱǂŴƶŴƽŴƖƐ˿ ƯƲƖōŗƶƶŴƐū˿ ĴƐœ ƶƽƲŗĴƏŴƐū ƖŪ `¼ œĴƽĴ 

IQS_Multithread_GetIQ_FFT_Write: Simultaneously acquires IQ data, performs FFT, and writes 

IQ data into a .txt file.  

1.5.18 WzÁÁʍººÁ ƽƲŴūūŗƲ 

IQS_GNSS_1PPS.cpp: Configure the trigger source to be the 1PPS signal provided by the 

internal GNSS system.  

1.5.19 `¼Á ƏǂƉƽŴœ̡ŗǚŴōŗ ƶǡƐōűƲƖƐŴǪĴƽŴƖƐ 

IQS_MultiDevSync_fixed.cpp: Multiple devices simultaneously collect the same signal at the 

same time.  
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1.5.20 BǠƽŗƲƐĴƉ ÈƲŴūūŗƲ 

IQS_ExternalTrigger.cpp: Configure the trigger source as external trigger.  

1.5.21 ÈŴƏŗƲ ÈƲŴūūŗƲ 

IQS_TimerTrigger.cpp: Configure the trigger source as timer trigger.  

1.5.22 sŗǚŗƉ ÈƲŴūūŗƲ̬ƯƲŗ̡ƽƲŴūūŗƲ ̭

IQS_LevelTrigger_PreTriggerr.cpp: Configure the trigger source as level trigger and set the 

pre - trigger time.  

1.5.23 sŗǚŗƉ ÈƲŴūūŗƲ ̬ÈƲŴūūŗƲ œŗƉĴǡ ̭

IQS_LevelTrigger_TriggerDelay.cpp: Configure the trigger source to be level trigger and set the 

trigger delay time.  

1.5.24 ÍƶŴƐū WzÁÁ ʍʌy]Ǫ ½ŗŪŗƲŗƐōŗ 8ƉƖōƇ 

IQS_Enable_GNSS_10MHz.cpp: Use a high - quality GNSS module's 10MHz reference clock in 

IQS mode.  

1.5.25 UŴǠŗœ ÁƽŗƯ yǂƉƽŴU̡ƲŗƱǂŗƐōǡ `¼ >ĴƽĴ ōƱǂŴƶŴƽŴƖƐ 

IQS_SetFreqScan: Configure the start and end frequencies and frequency points of IQ in 

advance. After configuring once, the data will be collected sequentially according to the set 

frequency points.  

1.6 >BÈyƖœŗ 

1.6.1 ¡ŌƽĴŴƐ œŗƽŗōƽŴƖƐ œĴƽĴ ŪƖƲ ŪŴǠŗœ ƯƖŴƐƽƶ ƖƲ ōƖƐƽŴƐǂƖǂƶ ƶƽƲŗĴƏƶ 

DETMode_Standard.cpp: Obtain detection data for fixed points or continuous streams.  

1.6.2 ½ŗĴœ ƽűŗ >BÈ ƶƽƲŗĴƏ œŴƶƇ œĴƽĴ ƖŪ ƯƯƉŴōĴƽŴƖƐ ÁƖŪƽǛĴƲŗ 

DETMode_PlayBack.cpp: Read the recorded files in DET mode from Application Software and 

output the detection data to the DETMode_Data.txt file.  

1.6.3 ºǂƉƶŗ œŗƽŗōƽŴƖƐ ̬ƽƖ Ōŗ ƖƯŗƐŗœ ƉĴƽŗƲ̭ 

1.7 ½ÈyƖœŗ 

1.7.1 ¡ŌƽĴŴƐ ƲŗĴƉƽ̡ŴƏŗ ƶƯŗōƽƲǂƏ œĴƽĴ ŪƖƲ ŪŴǠŗœ ƯƖŴƐƽƶ ƖƲ ōƖƐƽŴƐǂƖǂƶ ƶƽƲŗĴƏ 

RTAMode_Standard.cpp: Obtain real - time spectrum data for a fixed number of points 

(duration) or continuous stream.  
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1.7.2 ½ŗĴœ ƽűŗ ½È ƶƽƲŗĴƏ œŴƶƇ œĴƽĴ ƖŪ ƯƯƉŴōĴƽŴƖƐ ÁƖŪƽǛĴƲŗ 

RTAMode_PlayBack.cpp: Read the recorded file data in RTA mode from Application Software, 

while being able to specify reading a certain packet of data, and write the read spectrum data 

to the RTAMode_Data.txt file.  

1.7.3 ÈŴƏŗ ōƖƐƶǂƏƯƽŴƖƐ ƖŪ ŗĴōű ŪƲĴƏŗ ƖŪ œĴƽĴ ŴƐ ½È ƏƖœŗ 

RTAMode_Standard_perframe.cpp: Acquire 100 frames of data and calculate the average 

processing time for each frame.  

1.8 ÁWÁŴūƐĴƉ ÁƖǂƲōŗ ̬ƖƯƽŴƖƐĴƉ̭ 

1.8.1 ¡ǂƽƯǂƽ ƶŴƐūƉŗ ƽƖƐŗ̌ƶǛŗŗƯ̌ƯƖǛŗƲ ƶōĴƐ ƶŴūƐĴƉƶ 

ASG_SignalOutput.cpp: Output single tone/sweep/power scan signals as needed.  
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2. Qt  

2.1 8ƖƐŪŴūǂƲŗ >ŗǚŗƉƖƯƏŗƐƽ BƐǚŴƲƖƐƏŗƐƽ 

The following uses the configuration of an x64 architecture development environment as an 

example . 

1. Create a new folder (taking "QtTest" as an example) to store the project files; 

2. Copy the "Windows\HTRA_API\x64\htra_api" folder from the provided USB drive into the 

newly created "QtTest" folder; 

3. Open Qt Creator, and click "File" -> "New File or Project"; 

4. In project dialog, click "Application (Qt)", select "Qt Widgets Application", then click 

"Choose…"; 

5. Enter the project name (e.g., "test"), click the "Browse" button, select the previously created 

"QtTest" folder, and then click "Next"; 

6. Select "qmake", continue by clicking "Next" until the "Kit Selection" screen appears. On this 

screen, choose a build environment, and then click "Next"; 

 
Figure 11 Select the build environment 

7. Click "Finish" to create the project; 

8. In the Qt Creator main interface, right-click the "Test" project, select "Add Library…" -> 

"External Library" -> "Next"; 

9. Click to browse the library file, select the htra_api.lib library in "QtTest\htra_api", and click 

"Open"; 

10. Uncheck all options under Windows, then click "Static Library", finally select the Windows 

platform, and click "Next"; 
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Figure 12 Set the build configuration 

11. Click "Finish" to add the external library; Delete the last line ŗƉƶŗ̀ǛŴƐʏʎ̡

ūͺͺ̀º½B̦È ½WBÈ>BºÁͺ;ͫͫºæ>̌˾˾̌űƽƲĴ̦ĴƯŴ̌ƉŴŌűƽƲĴ̦ĴƯŴ˾Ĵ in the "test.pro" file. After saving, 

you can write project code normally; 

 
Figure 13 Modify the test.pro file 

12. After writing the code, click "Run". The program running correctly is illustrated as follows. 

 

Figure 14 Result 
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2.2 ¼ƽBǠĴƏƯƉŗ ÍƶĴūŗ ºƲƖōŗƶƶ 

Note: Only one example can run at a time; the example and SAStudio4 cannot run 

simultaneously . 

All Qt examples on the provided USB drive follow the same usage process. The following 

introduces the usage of the HTRA_Qt_Example project as an example : 

1. Use Qt Creator to open the htrademo.pro file located in the 

Windows\HTRA_API_Example\HTRA_Qt_Examples\htrademo folder on the USB drive; 

2. Click "Projects" to configure a 64-bit build environment for the project (the provided 

example uses 64-bit library files. If you need to use a 32-bit build environment, replace the 

libraries in the "HTRA_Qt_Example\htra_api" folder with the 32-bit libraries from 

"\Windows\HTRA_API\x86"); 

 

Figure 15 Configure a 64-bit build environment 

3. After configuring the environment, click "Edit" to open main.cpp in the Sources folder of the 

"HTRA_Qt_Example" project. Uncomment the relevant functions, save the file, and click 

"Run" to execute different examples. 

 

Figure 16 Running the QT Example 
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2.3 ¼ƽBǠĴƏƯƉŗ >ŗƶōƲŴƯƽŴƖƐ 

The Qt examples on the USB stick include a general example (HTRA_Qt_Example), an FM and 

AM demodulation example (HTRA_Demodulation), and an IQ to Spectrum example 

(IQS_ToSpectrumBuLiquid) using the Liquid library, refer to the C/C++ examples chapter for 

specific examples . 
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3. Python  

3.1 8ƖƐŪŴūǂƲŗ >ŗǚŗƉƖƯƏŗƐƽ BƐǚŴƲƖƐƏŗƐƽ 

1. Create a new folder on the desktop (e.g., TEST); 

2. Open the provided USB drive, go to 

"\Windows\HTRA_API_Example\HTRA_Python_Examples", and copy the "HTRA_API" 

folder and "htra_api.py" file into the newly created test folder; 

3. Open Visual Studio Code, click "File" → "Open Folder", and select the newly created test 

folder; 

4. In the left Explorer panel, click the "New File" icon to create a new Python file (e.g., test.py), 

and you can start writing code normally. 

 
Figure 17 Creating a New Python Project 
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3.2 ºǡƽűƖƐBǠĴƏƯƉŗ ÍƶĴūŗ ºƲƖōŗƶƶ 

1. Open the "Windows\HTRA_API_Example\HTRA_Python_Examples" project folder on the 

provided USB drive using Visual Studio Code or another IDE. The "htra_api.py" file is the 

Python mapping for the dynamic library, and the other files are example programs; 

2. After properly configuring the Python environment, select any example program (e.g., 

SWPMode_Standard.py) and run the file directly. The program running successfully is 

illustrated as follows: 

 

Figure 18 Running SWPMode_Standard.py 
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3.3 ºǡƽűƖƐBǠĴƏƯƉŗ >ŗƶōƲŴƯƽŴƖƐ 

3.3.1 Wŗƽ œŗǚŴōŗ ŴƐŪƖƲƏĴƽŴƖƐ 

Device_GetDeviceInfo.py: Retrieves various device information, including API version, USB 

version, device model, device UID, MCU version, FPGA version, and device temperature.  

3.3.2 ¡ŌƽĴŴƐ ÁƽĴƐœĴƲœ ÁƯŗōƽƲǂƏ >ĴƽĴ 

SWP_GetSpectrum_Standard.py: Obtains complete spectrum data within a specified 

frequency band (Plotting the spectrum if the host computer includes the matplotlib library) . 

3.3.3 ¡ŌƽĴŴƐ `¼ >ĴƽĴ ŪƖƲ Ĵ UŴǠŗœ zǂƏŌŗƲ ƖŪ ºƖŴƐƽƶ ƖƲ >ǂƲĴƽŴƖƐ 

IQS_GetIQdata_Standard.py: Obtains IQ data under different trigger modes in IQS mode.  

3.3.4 ¡ŌƽĴŴƐ ºƖǛŗƲ >ŗƽŗōƽŴƖƐ >ĴƽĴ ŪƖƲ Ĵ UŴǠŗœ zǂƏŌŗƲ ƖŪ ºƖŴƐƽƶ ƖƲ >ǂƲĴƽŴƖƐ 

DET_GetPowerTrace_Standard.py: Obtains power detection data under different trigger 

modes in DET mode (Plotting the Time - power graph  if the host computer includes the 

matplotlib library) . 

3.3.5 ¡ŌƽĴŴƐ ƲŗĴƉƽ̡ŴƏŗ ƶƯŗōƽƲǂƏ œĴƽĴ ŪƖƲ Ĵ ŪŴǠŗœ ƐǂƏŌŗƲ ƖŪ ƯƖŴƐƽƶ ƖƲ œǂƲĴƽŴƖƐ 

RTA_GetRealTimeSpectrum_Standard.py: Obtain real - time spectrum data under different 

trigger modes in RTA mode.  

3.3.6 `¼ ƽƖ ÁƯŗōƽƲǂƏ >ĴƽĴ 

DSP_IQSToSpectrum.py: Convert the IQ data obtained in IQS mode into spectrum data( If the 

host computer contains the matplotlib library then plot the spectrum and IQ time - domain 

graphs ). 

3.3.7 WzÁÁ ½ŗƉĴƽŗœ 

Device_AboutGNSS.py: Obtain information such as longitude, latitude, altitude, and time 

acquired by the GNSS module; obtain the longitude, latitude, and time information from the 

MeasAuxInfo structure in IQS mode.  
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4. Matlab  

The following uses Matlab 2016a as an example to demonstrate how to call the 64 - bit htra_api 

dynamic link library.  

4.1 ½ǂƐƐŴƐū ƽűŗ yĴƽƉĴŌ BǠĴƏƯƉŗ 

1. Download and install a C++ compiler; 

2. After properly connecting the device, open Matlab. Copy the current path of the 

"Windows\HTRA_API_Example\HTRA_Matlab_Examples" folder from the provided USB 

drive into Matlab's file path box and press Enter; 

3. Click the SWPMode_Standard.m file on the left, and confirm whether the compiler address 

in the first line of the example is consistent with the compiler path installed on the local 

system; 

 

Figure 19 Confirm the compilatopm address 

4. Click "Run". The appearance of the Figure 1 window indicates successful execution of the 

example. For functional descriptions of each example, please refer to the Introduction to 

Accompanying Examples section in the accompanying materials. 

 

Figure 20 Run the SWPMode_Standard.m File 

Note: Since calling the dynamic link library requires a C++ compiler, it is recommended to use 

MSYS2 to install the g++ compiler. Refer to https://www.msys2.org/  for download and 

installation instructions .  

https://www.msys2.org/
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4.2 `ƐƽƲƖœǂōƽŴƖƐ ƽƖ ōōƖƏƯĴƐǡŴƐūBǠĴƏƯƉŗƶ 

4.2.1 Wŗƽ œŗǚŴōŗ ŴƐŪƖƲƏĴƽŴƖƐ 

Device_QueryDeviceInfo.m: Retrieve device information, including API version, USB version, 

device model, device UID, MCU version, FPGA version, and device temperature.  

4.2.2 ¡ŌƽĴŴƐ ÁƽĴƐœĴƲœ ÁƯŗōƽƲǂƏ >ĴƽĴ 

SWPMode_Standard.m: Obtain complete spectrum data within the specified frequency band.  

4.2.3 8ƲŗĴƽŗ ƏǂƉƽŴƯƉŗ ƏĴƲƇŗƲƶ ƽƖ œŴƶƯƉĴǡ ŪƲŗƱǂŗƐōǡ ĴƐœ ƯƖǛŗƲ ƖŪ ƽűŗ ƏĴƲƇŗƲƶ 

CreatPeakMarker.m: Obtain spectrum data within the specified frequency band, create 

markers, and perform peak searching.  

4.2.4 8ƖƉƉŗōƽ ƽűŗ ƯŗĴƇ ƶƯŗōƽƲǂƏ ŗǚŗƲǡ ŪŴǚŗ ƏŴƐǂƽŗƶ 

SWPMode_per5minute_findMax.m: Obtain spectrum data within the specified frequency band 

and search for the peak globally every five minutes.  

4.2.5 ¡ŌƽĴŴƐ ōƖƐƽŴƐǂƖǂƶ ƶƽƲŗĴƏ ƖƲ ŪŴǠŗœ ƐǂƏŌŗƲ ƖŪ `¼ œĴƽĴ 

IQSMode_Standard.m: Acquire IQ data under different trigger modes in IQS mode.  

4.2.6 Èűŗ ĴōƱǂŴƲŗœ `¼ œĴƽĴ Ŵƶ ōƖƐǚŗƲƽŗœ ŴƐƽƖ ƶƯŗōƽƲǂƏ œĴƽĴ 

DSP_IQSToSpectrum.m: After acquiring IQ data, the obtained IQ data is converted into 

spectrum data.  

4.2.7 ōƱǂŴƲŗ ōƖƐƽŴƐǂƖǂƶ ƶƽƲŗĴƏ ƖƲ ŪŴǠŗœ ƐǂƏŌŗƲ ƖŪ ƯƖǛŗƲ œŗƽŗōƽŴƖƐ œĴƽĴ 

DET_GetPowerTrace_FixedPoints.m: Acquire power detection data under different triggering 

modes in DET mode.  

4.2.8 ōƱǂŴƲŗ ōƖƐƽŴƐǂƖǂƶ ƶƽƲŗĴƏ ƖƲ ŪŴǠŗœ œǂƲĴƽŴƖƐ ƲŗĴƉƽ̡ŴƏŗ ƶƯŗōƽƲǂƏ œĴƽĴ 

RTAMode_FixedPoints.m: Acquire real - time spectrum data under different triggering modes in 

RTA mode.  

4.2.9 `ƐƽŗƲƐĴƉ ƶŴūƐĴƉ ƶƖǂƲōŗ ƖǂƽƯǂƽ ƶŴūƐĴƉ 

ASG_CWOutput.m: Output single - tone signals, frequency sweep signals, and power sweep 

signals. Applicable only to devices with signal source options.  

4.2.10 sƖōƇ WzÁÁ ĴƐƽŗƐƐĴ ĴƐœ >¡8ë¡ ƖƶōŴƉƉĴƽƖƲ 

GNSS_DOCXO_LockState.m: Call the API interface to lock the GNSS antenna and DOCXO 

oscillator, applicable only to devices with IO expansion board options.  
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4.2.11 yǂƉƽŴƏ̡ĴōűŴƐŗ ƶǡƐōűƲƖƐŴǪĴƽŴƖƐ 

IQSMode_MultiDevSync_Standard.m: When using the same reference clock source input and 

the same trigger source input, two devices simultaneously acquire IQ data, allowing for the 

observation of the synchronization of their collected data.  
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5. C#  

5.1 8ƖƐŪŴūǂƲŗ >ŗǚŗƉƖƯƏŗƐƽ BƐǚŴƲƖƐƏŗƐƽ 

5.1.1 >ŗǚŗƉƖƯƏŗƐƽ BƐǚŴƲƖƐƏŗƐƽ 8ƖƐŪŴƲƏĴƽŴƖƐ 

Open the Visual Studio Installer, select the .NET Desktop Development and Universal Windows 

Platform Development components, then click Modify to ensure that Visual Studio 2019 

includes the C# development environment.  

 
Figure 21 Configuring the C# Development Environment in Visual Studio 

5.1.2 ºƲƖƃŗōƽ ÁŗƽǂƯ 

1. Open Visual Studio 2019 and click "Create a new project"; 

2. Select "C# Console Application" and click "Next"; 

3. Enter the project name and location, uncheck "Place solution and project in the same 

directory." Select ".NET Framework 4.5" as the framework, and then click "Create"; 

4. After the project is created, open the project, right-click the solution, and select "Add New 

Project"; 

5. In the "Add New Project" dialog, select "Library" as the project type, then choose "Class 

Library (Universal Windows)" under C#, and click "Next"; 
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Figure 22 Add New Project 

6. Modify the project name as needed (e.g., HtraApi), keep the default location, select ".NET 

Framework 4.5" as the framework, and click "Create"; 

7. Right-click ConsoleApp1 and select "Properties". In the project properties window, click the 

"Build" tab and change the "Platform target" to "x86". Then click the "Debug" tab, enter 

"htra_api" in the "Working directory" field, click "OK" in the popup, and finally save and close 

the properties window; 

 
Figure 23 Configure Project Properties 

8. Right-click the library HtraApi and select "Properties". In the library properties window, click 

the "Build" tab, change the "Platform target" to "x86," and save; 

9. Copy the contents of the HtraApi.cs file from the 

"\Windows\HTRA_API_Example\HTRA_CSharp_Examples" folder on the provided USB 

drive into the Class1.cs file in the project library, replace the code, and save; 
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10. Select the ConsoleApp1 project, right-click "References," choose "Add Reference," check 

the HtraApi library in the project, click "OK," and confirm that the library reference has been 

added; 

 

Figure 24 Add Library Reference 

11. Copy the htra_api folder from the "\Windows\HTRA_API\x86" directory on the provided 

USB drive to the "bin\Debug" folder of the project, and ensure that the "Htra_api\CalFile" 

folder contains the calibration files for the instruments being used; 

 

Figure 25 Copy the htra_api file 

12. You can refer to the C# examples on the provided USB drive and write code as needed; 

 

Figure 26 Write C# example 
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5.2 8 B̋ǠĴƏƯƉŗ ÍƶĴūŗ ºƲƖōŗƶƶ 

1. Open the solution HTRA_CSharp_Examples.sln in Visual Studio from the 

"\Windows\HTRA_API_Example\HTRA_CSharp_Examples" folder on the provided USB 

drive; 

2. Click the HTRA_CSharp_Examples project on the right, then open the Program.cs file within 

it; 

 
Figure 27 Open the Programe.cs file 

3. Each routine in the provided C# examples is encapsulated in a separate class. To use a 

routine, simply uncomment it (multiple examples cannot be used simultaneously). 

For example, to use the Device_GetDeviceInfo routine, uncomment it and run the program. 

A successful run is illustrated as follows; 

 

Figure 28 Run Device_GetDeviceInfo.cs 
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5.3 8 B̋ǠĴƏƯƉŗ >ŗƶōƲŴƯƽŴƖƐƶ 

5.3.1 Wŗƽ œŗǚŴōŗ ŴƐŪƖƲƏĴƽŴƖƐ 

Device_GetDeviceInfo.cs: Retrieves device information including API version, USB version, 

device model, device UID, MCU version, FPGA version, and device temperature.  

5.3.2 ¡ŌƽĴŴƐ ÁƽĴƐœĴƲœ ÁƯŗōƽƲǂƏ >ĴƽĴ 

SWP_GetSpectrum_Standard.cs: Obtains complete spectrum data within a specified 

frequency band.  

5.3.3 ¡ŌƽĴŴƐ `¼ >ĴƽĴ ŪƖƲ Ĵ UŴǠŗœ zǂƏŌŗƲ ƖŪ ºƖŴƐƽƶ ƖƲ >ǂƲĴƽŴƖƐ 

IQS_GetIQdata_Standard.cs: Acquires IQ data under different trigger modes in IQS mode.  

5.3.4 ¡ŌƽĴŴƐ ºƖǛŗƲ >ŗƽŗōƽŴƖƐ >ĴƽĴ ŪƖƲ Ĵ UŴǠŗœ zǂƏŌŗƲ ƖŪ ºƖŴƐƽƶ ƖƲ >ǂƲĴƽŴƖƐ 

DET_GetPowerTrace_Standard.cs: Obtains power detection data under different trigger 

modes in DET mode.  

5.3.5 ¡ŌƽĴŴƐ ƲŗĴƉƽ̡ŴƏŗ ƶƯŗōƽƲǂƏ œĴƽĴ ŪƖƲ Ĵ ŪŴǠŗœ ƐǂƏŌŗƲ ƖŪ ƯƖŴƐƽƶ ƖƲ œǂƲĴƽŴƖƐ 

RTA_GetRealTimeSpectrum_Standard.cs: Retrieves real - time spectrum data under different 

trigger modes in RTA mode.  

5.3.6 ¡ǂƽƯǂƽ ƶŴƐūƉŗƽ̡ƖƐŗ ƶŴūƐĴƉ 

ASG_CWOutput.cs: Devices with signal source functionality options output single - tone signals, 

frequency sweep signals, or power sweep signals through ASG functionality.  

5.3.7 y̌Uy >ŗƏƖœǂƉĴƽŴƖƐ 

Demodulation.cs: DSP_FMDemod performs FM demodulation and playback of the acquired IQ 

data. DSP_AMDemod performs AM demodulation and playback of the acquired IQ data.  

5.3.8 `¼ ƽƖ ÁƯŗōƽƲǂƏ >ĴƽĴ 

DSP_IQSToSpectrum.cs: Converts the IQ data obtained in IQS mode into spectrum data.  

5.3.9 sƖǛ̡ƯĴƶƶ ŪŴƉƽŗƲŴƐū 

DSP_LPF.cs: Applies low - pass filtering to the acquired IQ data and converts it to spectrum.  

5.3.10 >ŴūŴƽĴƉ >ƖǛƐōƖƐǚŗƲƶŴƖƐ 

DSP_DDC.cs: Performs digital down - conversion on the acquired IQ data and converts it to 

spectrum.  

5.3.11 ºűĴƶŗ ƐƖŴƶŗ ƽŗƶƽ 

DSP_TraceAnalysis_PhaseNoise.cs: Demonstration of Phase Noise Test Function . 
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6. Labview  

6.1 8ƖƐŪŴūǂƲŗ >ŗǚŗƉƖƯƏŗƐƽ BƐǚŴƲƖƐƏŗƐƽ 

6.1.1 ÍƶŴƐū ƽűŗ º` ŴƐ ƽűŗ sĴŌå`Bæ BƐǚŴƲƖƐƏŗƐƽ 

1. Open LabVIEW, click "Create Project", select "Project", and click "Finish". An untitled empty 

project will appear. Press "Ctrl+S" to save the project, choose the save path, enter a project 

name (e.g., HTRA_Labview_Examples), and click "OK"; 

2. Copy the "htra_api" folder from the 

"\Windows\HTRA_API_Example\HTRA_Labview_Examples" directory on the USB drive to 

the same directory level as the project. Additionally, you may create an "Examples" folder to 

store example VIs. If needed, you can also create another folder such as "Subvi" to store 

sub-VIs; 

 
Figure 29 Copy htra_api 

3. In the LabVIEW project, add the newly created Examples folder and the htra_api folder to 

the project, then save it; 

 

Figure 30 Add to project 

4. Create a new VI in the Examples folder. In the block diagram, you can call the exported 
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LabVIEW API functions. The calling process is the same as in the C environment; 

 
Figure 31 Create VI 

5. Finally, save the VI to the Examples folder and rename it as needed. 
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6.2 sĴŌǚŴŗǛ BǠĴƏƯƉŗ ÍƶĴūŗ ºƲƖōŗƶƶ 

The usage process of Labview examples included in the USB drive is as follows:  

1. Use LabVIEW to open the project "HTRA_Labview_Examples.lvproj" located in the USB drive 

under Windows\HTRA_API_Example\HTRA_Labview_Examples; 

 

Figure 32 Open Labview Project 

2. Double-click any example VI in the Example folder. Here, SWP_GetSpectrum_Standard.vi is 

used as an example; 

 
Figure 33 Open example 

3. After opening the VI, click the Run button in the upper-left corner to execute the program. 

The running interface is shown below; 
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Figure 34 Successfully Run the SWP_GetSpectrum_Standard Example 
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6.3 sĴŌǚŴŗǛBǠĴƏƯƉŗ >ŗƶōƲŴƯƽŴƖƐ 

6.3.1 Wŗƽ œŗǚŴōŗ ŴƐŪƖƲƏĴƽŴƖƐ 

Device_GetDeviceInfo.vi: An example for obtaining various device information, including: API 

version, device model, device UID, MCU version, FPGA version, and device temperature.  

6.3.2 ÁƽĴƐœĴƲœ ƶƯŗōƽƲǂƏ ĴōƱǂŴƶŴƽŴƖƐ 

SWP_GetSpectrum_Standard.vi: Obtains standard spectrum data within a specified frequency 

band and displays the image.  

6.3.3 ¡ŌƽĴŴƐ `¼ >ĴƽĴ ŪƖƲ Ĵ UŴǠŗœ zǂƏŌŗƲ ƖŪ ºƖŴƐƽƶ ƖƲ >ǂƲĴƽŴƖƐ 

IQS_GetIQ_FixedPoints.vi: Obtains IQ data with a fixed number of points. When the device 

receives a Bus trigger signal, it returns IQ data with a fixed number of points.  

6.3.4 ÁƽƲŗĴƏŴƐū ĴƐœ ƲŗĴœŴƐū `¼ œĴƽĴ 

IQS_RecordAndPlayback.vi: Obtains IQ data, records the IQ data as a txt file, and plays back 

the recorded IQ data.  

6.3.5 `¼ ƽƖ ÁƯŗōƽƲǂƏ >ĴƽĴ 

DSP_IQSToSpectrum.vi: Obtains IQ data and converts the acquired IQ data into spectrum data.  

6.3.6 >ŴūŴƽĴƉ >ƖǛƐōƖƐǚŗƲƶŴƖƐ 

DSP_DDC.vi: Performs digital downconversion on the IQ data stream and resamples to 

generate a sub - IQ stream for further spectrum analysis.  

6.3.7 ǂœŴƖ ƐĴƉǡƶŴƶ 

DSP_AudioAnalysis.vi: Analyzes audio voltage (V), audio frequency (Hz), signal - to - noise ratio 

(dB), and total harmonic distortion (%).  

6.3.8 ¡ŌƽĴŴƐ ºƖǛŗƲ >ŗƽŗōƽŴƖƐ >ĴƽĴ ŪƖƲ Ĵ UŴǠŗœ zǂƏŌŗƲ ƖŪ ºƖŴƐƽƶ ƖƲ >ǂƲĴƽŴƖƐ 

DET_GetPowerTrace.vi: Obtain a fixed number of DET data points. When the device receives a 

Bus trigger signal, it returns a fixed number of DET data points.  

6.3.9 ¡ŌƽĴŴƐ ƲŗĴƉƽ̡ŴƏŗ ƶƯŗōƽƲǂƏ œĴƽĴ ŪƖƲ Ĵ ŪŴǠŗœ ƐǂƏŌŗƲ ƖŪ ƯƖŴƐƽƶ ƖƲ œǂƲĴƽŴƖƐ 

RTA_GetRealTimeSpectrum.vi: Obtain a fixed number of RTA data points. When the device 

receives a Bus trigger signal, it returns a fixed number of RTA data points.  

6.3.10 ÁW ÁŴūƐĴƉ ÁƖǂƲōŗ ¡ǂƽƯǂƽ ÁŴūƐĴƉ 

ASG_CWOutput.vi: Control the internal signal generator of the device to output single - tone 

signals, sweep signals, and power scan signals.  

  



 

HAROGIC HTRA API Examples Usage Guide 33 

7. Linux  

7.1 BƐǚŴƲƖƐƏŗƐƽ åŗƲƶŴƖƐ 8ƖƏƯĴƽŴŌŴƉŴƽǡ ÁŗƉŪ8̡űŗōƇ 

When using the device in a Linux system, you first need to confirm whether the current Linux 

environment's system architecture, gcc version, and GLIBC version are supported according 

to the following process:  

1. Open the terminal and enter ǂƐĴƏŗ̡Ĵ to check the Linux system architecture, for example, 

here the Linux system architecture is x86_64; 

2. In the terminal, enter ūōō̡ǚ to check the system gcc version, for example, here the gcc 

version is 7.5.0; 

3. In the terminal, enter Ɖœœ̡ǚ̡ŗƲƶŴƖƐ to check the system GLIBC version, for example, here 

the GLIBC version is 2.27; 

 

Figure 35 Check the Linux System Architecture and Version 

4. Compare the terminal information with the table to confirm whether the current 

environment is supported. If it is not supported, please contact technical support. 

ÈĴŌƉŗʍÈŗƲƏŴƐĴƉ `ƐŪƖƲƏĴƽŴƖƐ 8ƖƏƯĴƲŴƶƖƐ ÈĴŌƉŗ 

ǠʔʒƯƲƖōŗƶƶƖƲ Support Intel and AMD processors 

½y ƯƲƖōŗƶƶƖƲ aarch64 (armv8), armv7 processors, such as: Raspberry Pi 4b, RK3399, 
RK3568, RK3588, T507, NVIDIA Jetson TX2 

8ƖƏƯŴƉĴƽŴƖƐ
ŗƐǚŴƲƖƐƏŗƐƽ gcc4.8, glib2.17 and above 

>ŴƶƽƲŴŌǂƽŴƖƐ Customized system for Raspberry Pi 4b, Ubuntu 18.04, etc. 
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7.2 ōōƖƏƯĴƐǡŴƐū œƖōǂƏŗƐƽĴƽŴƖƐ 

Currently, the Linux section of the accompanying USB drive contains the following materials:  

7.2.1 ]È½ ̦8ͺͺ̦BǠĴƏƯƉŗƶ 

The HTRA_C++_Examples folder contains : 

1. Examples folder: C++ example programs (see the C++ Example Usage section for 

instructions); 

2. Makefile: Build script used to compile the example programs into executables; 

3. bin folder: Stores device calibration files and the executables generated from building the 

example programs. 

 

Figure 36 Contents of the HTRA_C++_Examples Folder on Linux 

7.2.2 ]È½ ̦¼ƽ̦BǠĴƏƯƉŗƶ 

The HTRA_Qt_Examples folder contains : 

1. htrademo folder: Qt examples and .pro files (see the Qt Example Usage section for 

instructions); 

2. bin folder: Stores device calibration files and executables generated from compiling the 

example programs; 

3. htraapi folder: Stores the dynamic link libraries. 

 

Figure 37 Contents of the HTRA_Qt_Examples Folder on Linux 
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7.2.3 ]È½ ̦ºǡƽűƖƐ̦BǠĴƏƯƉŗƶ 

The HTRA_Python_Examples folder specifically contains : 

1. Python example programs (see the Python Example Usage section for instructions); 

2. CalFile folder: Stores device calibration files; 

3. Htraapi folder: Stores the dynamic link libraries. 

 
Figure 38 Contents of the HTRA_Python_Examples folder in Linux 

7.2.4 `ƐƶƽĴƉƉ̦]È½ ̦Á>q 

1. The Install_HTRA_SDK folder contains: 

 ̧ install_htraapi_lib.sh: Driver configuration script 

 ̧ htraapi folder: Stores drivers, header files, and libraries 

2. The Install_HTRA_SDK/htraapi folder contains:  

 ̧ configs folder: Driver configuration files 

 ̧ inc folder: Header files 

 ̧ lib folder: Dynamic link libraries 

3. The Install_HTRA_SDK/htraapi/lib folder contains: 

 ̧ arrch64 folder: ynamic link libraries for the arrch64 architecture 

 ̧ arrch64_gcc7.5 folder: Dynamic link libraries for arrch64 with more efficient FFT 

(requires GCC version above 7.5) 

 ̧ x86_64 folder: Dynamic link libraries for the x86_64 architecture 

 ̧ x86_64_gcc5.4 folder: Dynamic link libraries for x86_64 with more efficient FFT (requires 

GCC version above 5.4) 

 ̧ armv7 folder: Dynamic link libraries for the armv7 architecture 
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Figure 39 Contents of the Install_HTRA_SDK Folder on Linux  
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7.3 >ƲŴǚŗƲUŴƉŗ8ƖƐŪŴūǂƲĴƽŴƖƐ 

To use the device in Linux, the driver files must be configured first. The specific procedure is as 

follows : 

1. Configure the driver files: First, copy the Install_HTRA_SDK folder to the Linux host. Then, 

open a terminal in the Install_HTRA_SDK folder and enter ƶǂœƖ ƶű ŴƐƶƽĴƉƉ̦űƽƲĴĴƯŴ̦ƉŴŌ˾ƶű to 

configure the driver files. 

Note: If the development board does not have the sudo command, simply enter ƶű

ŴƐƶƽĴƉƉ̦űƽƲĴĴƯŴ̦ƉŴŌ˾ƶű. 

 

Figure 40 Configure driver files on Linux 

2. Configuration check: Ensure the device is correctly connected to the host computer (if the 

host computer is a virtual machine, ensure the device is connected to the virtual machine 

and that USB compatibility is 3.1) and provide normal power to the device. At this point, as 

shown in the figure, enter ƉƶǂƶŌ in the terminal to view the list of USB devices on the machine, 

where "ID: 6430 (or ID: 3675 or ID: 04b5)" indicates successful device connection. 

 
Figure 41 Check device connection status on Linux 

7.4 8ͺBͅǠĴƏƯƉŗ ÍƶĴūŗ ĴƐœ ºƲƖƃŗōƽ 8ƲŗĴƽŴƖƐ 

7.4.1 8ͺBͅǠĴƏƯƉŗ ÍƶĴūŗ 

Prerequisite: Ensure the device is properly connected and the driver files have been correctly 

configured as described in the Driver File Configuration  section.  

You can follow the process below and use the C++ examples provided on the USB drive (the 

specific functions of the examples can be found in the corresponding C/C++ sections ). 
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1. Select the program to compile: First, copy the "Linux\HTRA_C++_Examples" folder from the 

provided USB drive to the host computer. Then, open main.cpp in the Examples folder and 

uncomment the examples you want to test or use; 

 

Figure 42 Uncomment the SWP_GetSpectrum_Standard Example 

2. Compile the selected example: First, check the system architecture according to the 

Environment Version Compatibility Self-Check section. Open a terminal in the 

HTRA_C++_Examples folder and enter the corresponding command based on the host 

system architecture (the following example shows how to compile the 

SWP_GetSpectrum_Standard routine). 

 ̧ For x86_64 system: 

ƏĴƇŗ BǠĴƏƯƉŗ;Áæº̦WŗƽÁƯŗōƽƲǂƏ̦ÁƽĴƐœĴƲœ 

 ̧ For aarch64 system: 

ƏĴƇŗ È ½W;ĴĴƲōűʒʐ BǠĴƏƯƉŗ;Áæº̦WŗƽÁƯŗōƽƲǂƏ̦ÁƽĴƐœĴƲœ 

 ̧ For armv7 system: 

ƏĴƇŗ È ½W;ĴƲƏǚʓ BǠĴƏƯƉŗ;Áæº̦WŗƽÁƯŗōƽƲǂƏ̦ÁƽĴƐœĴƲœ 

 

Figure 43 Compile SWP_GetSpectrum_Standard on x86_64 System 

3. Verify the calibration files: Go to the "HTRA_C++_Examples\bin\CalFile" folder and ensure 

it contains the calibration files for the devices being used; 

 

Figure 44 Verify the calibration files 
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4. Run the program: After successfully compiling the program and verifying the calibration 

files, open a terminal and enter: 

˾̌ŌŴƐ̌Áæº̦WŗƽÁƯŗōƽƲǂƏ̦ÁƽĴƐœĴƲœ to run the selected example. 

 

Figure 45 Run the Compiled SWP_GetSpectrum_Standard Example 

7.4.2 8ͺºͅƲƖƃŗōƽ 8ƲŗĴƽŴƖƐ ĴƐœ 8ƖƏƯŴƉĴƽŴƖƐ 

Prerequisite: Correctly configure the driver files as described in the Driver File Configuration  

section . 

1  Write the code: 

The Linux dynamic libraries provided on the USB drive are identical to those on Windows. 

The code you write only needs to comply with the HAROGIC HTRA API Programming Guide. 

2  Compile and run: 

1). Create a new folder to store the entire project (e.g., C++_Test). Inside this folder, create a 

CalFile folder to store calibration files and an htraapi folder to store header files and 

dynamic link libraries; 

 

Figure 46 Create Project Folder 

2). Inside the htraapi folder, create an inc folder to store header files and a lib folder to store 

dynamic link libraries; 

 

Figure 47 Create inc and lib Folders under htraapi 
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3). Copy the files from the CalFile folder on the USB drive into the newly created 

"C++_Test\CalFile" folder; 

4). Copy the header files from "Linux\Install_HTRA_SDK\htraapi\inc" on the USB drive into the 

newly created "C++_Test\htraapi\inc" folder; 

5). heck the system architecture according to the Environment Version Compatibility Self-

Check section. Then, following the description of the lib folder, copy the files from the 

folder corresponding to your architecture into the "C++_Test\htraapi\lib" folder. (The 

illustration shows an x86_64 architecture host.); 

 

Figure 48 Copy the Dynamic Link Libraries for the Corresponding Architecture into the lib 

Folder 

6). Open a terminal in the lib folder and enter the following command to create symbolic links 

for the copied dynamic link libraries (the commands are the same for all three architectures): 

In the following, the libhtraapi.so library uses version 0.55.63 as an example; for other 

versions, simply adjust the version number accordingly: 

 ̧ ƉƐ̡ƶŪ ƉŴŌűƽƲĴĴƯŴ˾ƶƖ˾ʌ˾ʑʑ˾ʒʏƉŴŌűƽƲĴĴƯŴ˾ƶƖ˾ʌ 

 ̧ ƉƐ̡ƶŪ ƉŴŌűƽƲĴĴƯŴ˾ƶƖ˾ʌ ƉŴŌűƽƲĴĴƯŴ˾ƶƖ 

 ̧ ƉƐ̡ƶŪ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ˾ʌ˾ʎ˾ʌ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ˾ʌ 

 ̧ ƉƐ̡ƶŪ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ˾ʌ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ 

 ̧ ƉƐ̡ƶŪ ƉŴŌūƖƏƯ˾ƶƖ˾ʍ˾ʌ˾ʌ ƉŴŌūƖƏƯ˾ƶƖ˾ʍ 

 ̧ ƉƐ̡ƶŪ ƉŴŌūƖƏƯ˾ƶƖ˾ʍ ƉŴŌūƖƏƯ˾ƶƖ 
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Figure 49 Create Symbolic Links for Dynamic Link Libraries 

7). Place the written code files in the top-level folder of C++_Test; 

 

Figure 50 Place the Code Files 

8). 8ƖƏƯŴƉŗ ƽƖ ūŗƐŗƲĴƽŗ ƽűŗ ŗǠŗōǂƽĴŌƉŗ̀ 7Ĵƶŗœ ƖƐ ƽűŗ ƶǡƶƽŗƏ ĴƲōűŴƽŗōƽǂƲŗ ōƖƐŪŴƲƏŗœ ŴƐ ƽűŗ

BƐǚŴƲƖƐƏŗƐƽ åŗƲƶŴƖƐ 8ƖƏƯĴƽŴŌŴƉŴƽǡÁŗƉŪ8̡űŗōƇƶŗōƽŴƖƐ˿ ƖƯŗƐ Ĵ ƽŗƲƏŴƐĴƉ ŴƐ ƽűŗ 8ͺͺ̦Èŗƶƽ

ŪƖƉœŗƲ ĴƐœ ŗƐƽŗƲ ƽűŗ ōƖƏƏĴƐœ ōƖƲƲŗƶƯƖƐœŴƐū ƽƖ ǡƖǂƲ ĴƲōűŴƽŗōƽǂƲŗ ́

Èűŗ ŪƖƉƉƖǛŴƐū ŗǠĴƏƯƉŗ ǂƶŗƶ Èŗƶƽ˾ōƯƯ˾ 8ƖƏƯŴƉŗ Ŵƽ ƖƐ œŴŪŪŗƲŗƐƽ ƖƯŗƲĴƽŴƐū ƶǡƶƽŗƏƶ ƽƖ

ūŗƐŗƲĴƽŗ ĴƐ ŗǠŗōǂƽĴŌƉŗ ƐĴƏŗœ Èŗƶƽ ̀

 ̧ UƖƲǠʔʒ̦ʒʐƶǡƶƽŗƏ̀ 

ūͺͺ̡Ɩ Èŗƶƽ Èŗƶƽ˾ōƯƯƶ̡ƽœ;ōͺͺʍʍ̡̀ ˾̌űƽƲĴĴƯŴ̌ŴƐōs̡ ˾̌űƽƲĴĴƯŴ̌ƉŴŌƉ̡űƽƲĴĴƯŴæ̡Ɖ˿̡

ƲƯĴƽű;̓˾̌űƽƲĴĴƯŴ̌ƉŴŌ̓ 

 ̧ For arrch64 ƶǡƶƽŗƏ: 

ĴĴƲōűʒʐƉ̡ŴƐǂǠū̡Ɛǂ̡ūͺͺ̡Ɩ Èŗƶƽ Èŗƶƽ˾ōƯƯƶ̡ƽœ;ōͺͺʍʍ̡̀ ˾̌űƽƲĴĴƯŴ̌ŴƐōs̡ ˾̌űƽƲĴĴƯŴ̌ƉŴŌƉ̡űƽƲĴĴƯŴ

æ̡Ɖ˿̡ƲƯĴƽű;̓˾̌űƽƲĴĴƯŴ̌ƉŴŌ̓ 

 ̧ For armv7 system: 

ĴƲƏ̡ƉŴƐǂǠū̡ƐǂŗĴŌŴűŪū̡ͺͺ̡Ɩ Èŗƶƽ Èŗƶƽ˾ōƯƯƶ̡ƽœ;ōͺͺʍʍ̡̀ ˾̌űƽƲĴĴƯŴ̌ŴƐōs̡ ˾̌űƽƲĴĴƯŴ̌ƉŴŌ̡

ƉűƽƲĴĴƯŴæ̡Ɖ˿̡ƲƯĴƽű;̓˾̌űƽƲĴĴƯŴ̌ƉŴŌ̓ 
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Figure 51 Compile to Generate Executable 

9). Run the program: Enter ˾̌Èŗƶƽ to start the executable file. 

 
Figure 52 Run the Test Executable 

7.4.3 8ͺºͅƲƖƃŗōƽ 8ƲƖƶƶ8ƖƏƯŴƉĴƽŴƖƐ 

If the host computer has a cross - compilation toolchain and you want to cross - compile for the 

device, follow the process below . 

The following example shows how to cross - compile an aarch64 executable on an x86_64 host : 

1. Generate the executable for the target architecture: 

1). Follow steps 1 to 8 in the "C++ Project Creation and Compilation" section to create the 

project, place the calibration files, and add the aarch64 architecture header and library files. 

Then, create symbolic links, place the program code, and compile the executable using the 

target architecture compilation command. As shown below, when compiling an aarch64 

executable, use the compilation command for an aarch64 system. 

 

Figure 53 Cross-Compile an aarch64 Executable 
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2). After generating the executable, enter ŪŴƉŗ Èŗƶƽ to check the architecture of the executable. 

You should see that the current executable is for the aarch64 architecture. 

 

Figure 54 Check Executable Architecture 

2. Run the executable on an aarch64 host: 

1). Navigate to the project directory and execute ǪŴƯ̡Ʋ 8ͺͺ̦Èŗƶƽ˾ǪŴƯ 8ͺͺ̦Èŗƶƽ to compress the 

entire C++_Test folder into a ZIP archive. Then, copy the generated ZIP file to the aarch64 

host; 

 

Figure 55 Compress the Created Project 

2). On the aarch64 host, enter ǂƐǪŴƯ 8ͺͺ̦Èŗƶƽ˾ǪŴƯ to extract the project; 

3). Following the Driver File Configuration section, configure the driver files on the aarch64 

host; 

4). After configuring the driver files, go to the C++_Test folder and run the program by 

entering ./Test in the terminal. 
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7.5 ÍƶŴƐū ¼È BǠĴƏƯƉŗƶ ĴƐœ ºƲƖƃŗōƽ 8ƲŗĴƽŴƖƐ 

7.5.1 ¼ƽBǠĴƏƯƉŗ ÍƶĴūŗ ºƲƖōŗƶƶ 

Usage prerequisite: Ensure the device is properly connected and the driver files have been 

correctly configured according to the Driver File Configuration  chapter . 

The following example demonstrates how to run the Qt sample on Ubuntu 22.04, using an 

x86_64 architecture . 

1. Copy the "Linux\HTRA_Qt_Examples" folder from the included USB drive to the host PC; 

2. Refer to the Environment Version Compatibility Self-Check chapter to confirm the system 

architecture, then copy the contents from the corresponding architecture folder under 

"Linux\Install_HTRA_SDK\htraapi\lib" on the USB drive into the host PC’s 

"HTRA_Qt_Examples\htraapi" folder; 

 

Figure 56 Copy the dynamic libraries for the corresponding architecture 

3. Open a terminal in the htraapi folder and enter ƶǂœƖ ƶű ¼ƽ̦yĴƇŗ˾ƶű. When prompted, enter 

the password to authorize the creation of symbolic link; 

 

Figure 57 Create symbolic links for the dynamic libraries 
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4. Enter the "HTRA_Qt_Examples\bin\CalFile" folder and ensure that it contains the 

calibration files for the device in use; 

5. Use Qt Creator to open the htrademo.pro file located in "HTRA_Qt_Examples\htrademo", 

and configure the project's build environment; 

 

Figure 58 Build environment 

6. Click "Edit", open main.cpp under the "Sources" folder of the "htrademo" project, 

uncomment the relevant functions, save the file, and click Run to execute different 

examples; 

 

Figure 59 Run the SWP_GetSpectrum_Standard example 
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7.5.2 ¼ƽ ºƲƖƃŗōƽ 8ƲŗĴƽŴƖƐ ĴƐœ 8ƖƏƯŴƉĴƽŴƖƐ 

Provided that the driver files have been correctly configured as described in the Driver File 

Configuration  section, if you want to create and compile a Qt project, follow the process below:  

The code should follow the API Programming Guide, and the steps for creating a GUI 

application are as follows : 

1. Create a new folder to store the entire project (e.g., QtTest), including bin (for calibration 

files and generated executables) and htraapi (for header files and dynamic link libraries) 

subfolders; 

2. Copy the instrument-specific CalFile folder from the USB drive into the QtTest\bin folder; 

3. Copy the header files from Linux\Install_HTRA_SDK\htraapi\inc on the USB drive into the 

QtTest\htraapi folder; 

4. Copy the dynamic link libraries from the folder corresponding to your system architecture 

under Linux\Install_HTRA_SDK\htraapi\lib on the USB drive into the QtTest\htraapi folder 

(here, an x86_64 host is used as an example); 

 

Figure 60 Copy the dynamic link libraries for the corresponding architecture 

5. Open a terminal in the htraapi folder and enter the following commands in sequence to 

create symbolic links for the copied dynamic link libraries (the commands are the same for 

all architectures): 

In the following, the libhtraapi.so library uses version 0.55.63 as an example; for other 

versions, simply adjust the version number accordingly: 

 ̧ ƉƐ̡ƶŪ ƉŴŌűƽƲĴĴƯŴ˾ƶƖ˾ʌ˾ʑʑ˾ʒʏƉŴŌűƽƲĴĴƯŴ˾ƶƖ˾ʌ 

 ̧ ƉƐ̡ƶŪ ƉŴŌűƽƲĴĴƯŴ˾ƶƖ˾ʌ ƉŴŌűƽƲĴĴƯŴ˾ƶƖ 

 ̧ ƉƐ̡ƶŪ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ˾ʌ˾ʎ˾ʌ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ˾ʌ 

 ̧ ƉƐ̡ƶŪ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ˾ʌ ƉŴŌǂƶŌʍ̡˾ʌ˾ƶƖ 

 ̧ ƉƐ̡ƶŪ ƉŴŌūƖƏƯ˾ƶƖ˾ʍ˾ʌ˾ʌ ƉŴŌūƖƏƯ˾ƶƖ˾ʍ 

 ̧ ƉƐ̡ƶŪ ƉŴŌūƖƏƯ˾ƶƖ˾ʍ ƉŴŌūƖƏƯ˾ƶƖ 
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Figure 61 Create symbolic links for the dynamic libraries in htraapi 

6. Open Qt Creator and click "File" -> "New File or Project"; 

7. In the project options, click "Application", select "Qt Widgets Application", and click 

"Choose…"; 

8. Enter the project name (e.g., "test"), click "Browse", select the previously created "QtTest" 

folder, and then click "Next"; 

9. Select "qmake", click "Next" until the "Kit Selection" screen appears. On this screen, choose 

a build environment and click "Next"; 

10. Click "Finish" to create the project; 

11. In the Qt Creator main interface, right-click the "Test" project, select "Add Library…" -> 

"External Library" -> "Next"; 

12. Click "Browse" for the library file, select libhtraapi.so in "QtTest\htraapi", click "Open", 

choose the "Linux" platform, and click "Next". 

 
Figure 62 Select the Linux Platform 

13. Click "Finish" to add the external library; 
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14. In Test.pro, after CONFIG += c++11, add >BÁÈ>`½ ; ͫͫōƉŗĴƐ̦ƯĴƽű̬ͫͫºæ>̌˾˾̌ŌŴƐ̭ to specify 

the location for the generated executable; 

 
Figure 63 Specify the Executable Output Location 

15. After the library file, add æ̡Ɖ˿̡ƲƯĴƽű˿ͫͫºæ>̌˾˾̌űƽƲĴĴƯŴ to specify the runtime library path for 

the executable; 

 

Figure 64 Specify the Runtime Library Path for the Executable 

16. Save the Test.pro file, then write the code in mainwindow.cpp and click Run. The normal 

operating interface is shown below; 

 

Figure 65 Run the Code 



 

HAROGIC HTRA API Examples Usage Guide 49 

17. Close Qt Creator, navigate to the QtTest\bin folder, open a terminal, and enter ˾̌Èŗƶƽ to run 

the executable; 

 

Figure 66 Run the Executable 

7.5.3 ¼ƽ ºƲƖƃŗōƽ 8ƲƖƶƶ8̡ƖƏƯŴƉĴƽŴƖƐ 

If the host computer has a cross - compilation toolchain and you want to cross - compile for the 

device, follow the procedure below (here, an example of cross - compiling an aarch64 

executable on an x86_64 host is given) : 

1. First, generate the executable for the target architecture: 

1). Following steps 1 to 9 of the Qt Project Creation and Compilation process for a windowed 

application, create the project, place the calibration and header files, place the library files 

for the cross-compilation target architecture ($\text{aarch64}$), create a soft link (symlink) 

for the dynamic link libraries, create the program in Qt Creator, and select the 

$\text{aarch64}$ Build Kit 

 

Figure 67 Select the target kit for the cross-compilation target architecture 
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2). Follow steps 10 to 16 of the windowed application creation process to perform project 

creation, library referencing, modification of the executable program generation location, 

project coding, and running; 

 

Figure 68 Build the executable program for the aarch64 architecture 

3). After building the executable program, open the terminal in the QtTest\bin folder and enter 

file Test to view the executable program's architecture (the executable program name is 

Test, so the input command is file Test); 

 

Figure 69 View the executable program's architecture 

2. Run the executable program on the aarch64 architecture host machine: 

1). Enter the project directory (The example project is located on the Desktop, so enter cd 

Desktop/). Execute ǪŴƯ̡Ʋ ¼ƽÈŗƶƽ˾ǪŴƯ ¼ƽÈŗƶƽ to package the entire QtTest folder into a ZIP 

file. Then, copy the generated compressed package to the aarch64 host machine; 

 
Figure 70 Compress the created project 
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2). On the aarch64 host machine, enter ǂƐǪŴƯ ¼ƽÈŗƶƽ˾ǪŴƯ to unzip (or extract) the project; 

3). Refer to the section on Driver File Configuration to configure the driver files on the aarch64 

host machine; 

4). After configuring the driver files, enter the QtTest folder. In the terminal, enterōűƏƖœ ʓʓʓ

Èŗƶƽ to grant permissions to the executable program. Subsequently, you can run the 

program by entering ./Test. 

 

Figure 71 Grant permissions and run the executable program 
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7.6 ÍƶĴūŗ ƖŪ ºǡƽűƖƐ BǠĴƏƯƉŗƶ ĴƐœ ºƲƖƃŗōƽ 8ƲŗĴƽŴƖƐ 

7.6.1 ÍƶĴūŗ ƖŪºǡƽűƖƐBǠĴƏƯƉŗƶ 

Prerequisite: Ensure the device is properly connected and the driver files have been correctly 

configured according to the Diver  File Configuration  section . 

The functionality of the Python examples can be found in the Python Example Description 

chapter . 

1. Copy the "Linux\HTRA_Python_Examples" folder from the included USB drive to the host 

PC. In this folder, open a terminal and enter ǛűŴōű ƯǡƽűƖƐʏ to check the location of the 

Python interpreter (for example, here it is /usr/bin); 

 

Figure 72 Check the Python3 Interpreter Location 

2. Based on the obtained interpreter path, enter ƶǂœƖ ōƯƲ̡ 8ĴƉUŴƉŗ ̌ǂƶƲ̌ŌŴƐ to copy the device 

calibration files to the same directory as the Python interpreter. (If the interpreter is not 

located in /usr/bin, replace the path with the actual location.). 

 

Figure 73 Copy the Calibration Files to the Same Directory as the Interpreter 

3. Refer to the Environment Version Compatibility Self-Check chapter to confirm the system 

architecture, then copy the contents from the corresponding architecture folder under 

"Linux\Install_HTRA_SDK\htraapi\lib" on the USB drive into the host PC’s 

"HTRA_Python_Examples\htraapi" folder; 

 

Figure 74 Copy the Dynamic Link Libraries 
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4. Open a terminal in the htraapi folder, enter ƶǂœƖ ƶű ºǡ̦yĴƇŗ˾ƶű, and provide the password 

when prompted to grant permission for creating symbolic links for the libraries; 

 

Figure 75 Create symbolic links for the libraries in htraapi 

5. In the HTRA_Python_Examples folder, open a terminal and enter ƯǡƽűƖƐʏ

ÁæºyƖœŗ̦ÁƽĴƐœĴƲœ˾Ưǡ to run the provided SWPMode_Standard.py example. 

 
Figure 76 Run the Python Example 

Note: If running the Python example on a different device, first copy the calibration files to the 

"HTRA_Python_Examples \ CalFile " folder. Then, in a terminal within the 

HTRA_Python_Examples folder, enter sudo cp - r CalFile /usr/bin  to update the calibration files 

to the same directory as the Python interpreter . 

7.6.2 ºǡƽűƖƐ ºƲƖƃŗōƽ 8ƲŗĴƽŴƖƐ 

Provided that the driver files have been correctly configured as described in the Diver  File 

Configuration  section, if you want to create a Python project, follow the procedure below : 

1. The code should follow the HAROGIC HTRA API Programming Guide; 

2. When running the program, place it in the example folder (HTRA_Python_Examples) and 

follow the procedure in the Usage of Python Examples chapter. 
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